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Abstract
TBI causes both direct and delayed tissue damage. The latter is associated with secondary
biochemical changes such as cell cycle activation that lead to neuronal death, inflammation and glial
scarring. Flavopiridol — a CDK inhibitor that is neither specific nor selective — is neuroprotective.
To examine the role of more specific CDK inhibitors as potential neuroprotective agents, we studied
the effects of roscovitine in TBI. Central administration of roscovitine 30 minutes after injury resulted
in significantly decreased lesion volume, as well as improved motor and cognitive recovery.
Roscovitine attenuated neuronal death and inhibited activation of cell cycle pathways in neurons
after TBI, as indicated by attenuated cyclin G1 accumulation and phosphorylation of retinoblastoma
protein. Treatment also decreased microglial activation after TBI, as reflected by reductions in ED1,
Galectin-3, p22PHOX and Iba-1 levels, and attenuated astrogliosis as shown by decreased GFAP
accumulation. In primary cortical microglia and neuronal cultures, roscovitine and other selective
CDK inhibitors attenuated neuronal cell death, as well as decreasing microglial activation and
microglial-dependent neurotoxicity. These data support a multi-factorial neuroprotective effect of
cell cycle inhibition after TBI-likely related to inhibition of neuronal apoptosis, microglial-induced
inflammation and gliosis-and suggest that multiple CDKs are potentially involved in this process.
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Introduction
Traumatic brain injury (TBI) is a leading cause of morbidity and mortality in the children and
adult population. In 2003 there were over 1.5 million TBI-related injuries in the United States
resulting in approximately 1.2 million emergency room visits, 300,000 hospitalizations and
50,000 deaths. Annually, about 230,000 TBI survivors experience long-term disability from
cognitive, emotional, sensory, motor and other impairments, making TBI a major public health
problem.

In addition to causing direct mechanical injury, trauma initiates secondary cascades of
biochemical and cellular changes that substantially contribute to subsequent tissue damage and
related neurological deficits. Activation of specific signaling pathways in response to
mechanical trauma causes delayed neuronal apoptosis as well as inflammation and reactive

*These authors contributed equally to this manuscript.
#Corresponding author: Bogdan A. Stoica, M.D., Georgetown University School of Medicine, Department of Neuroscience, Research
Building, Room WG18, 3970 Reservoir Rd, NW, Washington, DC 20057, Office: 202.687.4609, Lab: 202.687.5172, Fax: 202.687.0617,
email: stoicab@georgetown.edu

NIH Public Access
Author Manuscript
J Cereb Blood Flow Metab. Author manuscript; available in PMC 2009 November 1.

Published in final edited form as:
J Cereb Blood Flow Metab. 2008 November ; 28(11): 1845–1859. doi:10.1038/jcbfm.2008.75.

N
IH

-PA Author M
anuscript

N
IH

-PA Author M
anuscript

N
IH

-PA Author M
anuscript



astrogliosis. Recent work has suggested a pathophysiological role for cell cycle pathways in
neuronal apoptosis associated with both acute and chronic neurodegeneration. Post-mitotic
cells such as neurons do not engage in cell cycle progression once they differentiate; thus, cell
cycle proteins are generally down-regulated in these cells. However, mature neurons have the
capacity to re-enter the cell cycle, a process that results in apoptosis rather than neuronal
proliferation (Nguyen et al 2002). Abortive re-entry into the cell cycle has been shown to
contribute to neuronal apoptosis in vitro and in vivo. Activation of cell cycle proteins has been
implicated in in vitro neuronal cell death caused by excitotoxic stress, ceramide, β-amyloid,
KCl withdrawal, trophic factor deprivation, and DNA damage of various etiologies (Kruman
et al 2004). Cyclin-dependent kinases (CDKs) may also participate in neuronal apoptosis in
the developing brain, as well as in neuronal degeneration in the adult brain following cerebral
ischemia, Alzheimer’s disease, Parkinson’s disease, and amyotrophic lateral sclerosis (Nguyen
et al 2003). Inhibition of cell cycle reactivation provides neuroprotection both in vitro and in
vivo (Wang et al 2002). Previous studies in our laboratory have examined the role of cell cycle
activation in the pathophysiology of experimental brain and spinal cord injury (SCI).
Activation of the cell cycle occurs after TBI in both neurons and glial cells but with different
downstream consequences: cellular proliferation/activation in astroglia and microglia cells
versus apoptosis in neurons and oligodendroglial cells (Byrnes et al 2007). CNS injuries such
as trauma and ischemia cause both proliferation of astroglia resulting in glial scar formation
and microglial activation associated with release of pro-inflammatory molecules that
contribute to neurotoxicity (Byrnes et al 2007). Although microglial activation may have
protective actions in some experimental models, inhibition of brain inflammatory responses
has proved neuroprotective in various models of neurodegeneration, as well as after
neurotrauma (Byrnes et al 2006).

Progression through the cell cycle is controlled by the interaction of numerous cell cycle
molecules including cyclins, CDKs and cyclin-dependent kinase inhibitors (CDKIs).
Activation of these pathways, which regulate cell division in mitotic cells, causes cell death in
mature neurons. Increased levels of G1 phase cyclins D and E associated with neuronal
apoptosis have been demonstrated both in in vitro and in vivo models of excitotoxicity(Park
et al 2000). Moreover, up-regulation of cyclins D, A, and B have been associated with toxin-
induced hippocampal damage whereas increased protein levels of cyclin D1 and CDK4 appear
to play a critical role in excitotoxin-induced neuronal cell death (Ino and Chiba 2001). Increased
protein levels of cyclin D1 and CDK4 have been linked to the programmed cell death of motor
neurons after spinal cord ischemia (Sakurai et al 2000). In rat fluid percussion TBI, injury
significantly increases the expression of many cell cycle-related genes while down-regulating
those of endogenous cell cycle inhibitors (Cernak et al 2005). Treatment with the powerful
cell cycle inhibitor flavopiridol decreases TBI-induced lesion volume and improves behavioral
outcomes following TBI (Cernak et al 2005), suggesting that modulation of the cell cycle
following injury might provide a mechanism for neuroprotection. Unfortunatelly, flavopiridol
is a relatively non-specific cell cycle inhibitor that also inhibits transcription, which
complicates interpretation of its mechanism of action.

In the present studies we examined the effects of post-injury administration of the more specific
cell cycle inhibitor roscovitine in a well-characterized rat TBI model. In parallel, we also
examined the effects of roscovitine on microglial activation and microglial-dependent
neurotoxicity using in vitro models.

Material and Methods
All protocols involving the use of animals complied with the Guide for the Care and Use of
Laboratory Animals published by NIH (DHEW publication NIH 85-23-2985) and were
approved by the Georgetown University Animal Use Committee.
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Reagents
Roscovitine was obained from LC Laboratories (Woburn, MA); Purvalanol A (#540500),
CDK1 inhibitor (#217695) and CDK4 inhibitor (#219477) were from Calbiochem (Gibbstown,
NJ). Etoposide was from Tocris (Ellisville, Missouri)

Induction of Injury
Fluid percussion-induced TBI was performed as previously described (Yakovlev et al 1997)
with some modifications. Briefly, male Sprague-Dawley rats (400±25 g) were housed in a 12
hour light, 12 hour dark cycle with free access to food and water. Rats were anesthetized with
sodium pentobarbital (60mg/kg i.p.), followed by intubation and ventilation and implantation
of a catheter in the tail artery to measure blood pressure. Temperature was measured rectally
and maintained at 36-37° C throughout the procedure. A 5mm craniotomy over the left parietal
cortex was placed midway between lambda and bregma and 3.9mm from the vertex and a metal
female leur loc disc was cemented to the site. The other end of the attachment was then fitted
to the fluid percussion device. Force of impact was controlled through a computer connected
to the device through PowerLab (AD Instruments, Colorado Springs, CO, USA) and recorded
through the Chart4Windows 4.2 software program (AD Instruments, Colorado Springs, CO).
All rats were subjected to moderate injury (2.7 to 2.9 atm). Thirty minutes after injury,
roscovitine (300nmoles of roscovitine in 10μl saline; this dose was chosen after pilot dose-
response studies) or an equal volume vehicle (saline) was injected ICV contralateral to the
injury site. Animals were sacrificed at 24 h or 7 days after injury (n=3-5 per group) for
immunocytochemical/stereological studies, or at 21 days for histology, behavior and
volumetric measurements (n=7-8 per group).

Neurologic Assessment
Motor and cognitive function was assessed post-injury using a composite neuroscore, as
previously described (Cernak et al 2004), and the Morris water maze (MWM) as previously
described (Faden et al 2003), respectively. Briefly, components of the composite neuroscore
include measures of forelimb flexion (right and left), lateral pulsion (right and left), and the
ability to maintain position on an angle board with animals positioned head up, head down,
and right and left horizontal positions, each rated 0-5. For the MWM, rats were trained to locate
a hidden, submerged platform using visual cues. The surface of the water was made opaque
with the administration of white, nontoxic paint (Crayola) to the water. During training, the
platform was maintained in a constant location in a single quadrant. The rat was placed in the
water facing the wall at one of four randomly placed locations around the circular pool and the
latency to find the hidden platform within 90 seconds was recorded. Trials were conducted on
days 14, 15, 16 and 17 following injury. To control for motor impairment, rats were tested to
locate a visible, elevated platform following the last training trial.

Microglial Cultures
Microglial cells were obtained from postnatal day 2 Sprague Dawley rat pups and cultured as
described previously (Byrnes et al 2006).

Microglial Proliferation and Activation
Microglia were stimulated with lipopolysaccharide (LPS, 1μg/ml, Sigma, St. Louis, MO) with
or without roscovitine (100 μM) pre-treatment (60 min). Microglial proliferation was then
assessed using the MTS assay (Promega, Madison, WI) according to the manufacturer’s
protocols. Microglia activation reflected by Nitric Oxide (NO) production was assayed using
the Griess Reagent Assay (Invitrogen, Carlsbad, CA), according to the manufacturer’s
instructions.
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Microglia-Induced Neurotoxicity
Rat primary cortical neuronal cultures were derived from E18 Sprague Dawley rat cortices
(Taconic, Germantown, NY) as previously described (Mukhin et al 1998). At day 7 in vitro,
media from microglia that had been stimulated with LPS with or without roscovitine pre-
treatment was transferred to the neuronal cultures. At 24 h after incubation with microglial-
conditioned media, the LDH release assay (CytoTox 96® Nonradioactive Cytotoxicity Assay
Kit, Promega, Madison, WI) was used to assess neuronal cell death.

Etoposide-Induced Neuronal cell death
For etoposide-induced neuronal cell death, primary neurons were pretreated with the various
CDK inhibitors (roscovitine 25μM, 50μM, 100μM; purvanalol A 25μM, 50μM; CDK1
inhibitor 25μM, 50μM, 100μM; and CDK4 inhibitor 25μM, 50μM) followed by exposure to
etoposide (50μM). After 24 h neuronal cell death was determined using the LDH assay as
described.

Immunocytochemistry/Stereology
At 24 h and 7 days after injury, animals were sacrificed and brains harvested for
histopathological analyses as described (Di Giovanni et al 2005). Brains were frozen-sliced
on a cryostat at a thickness of 20μm, collected at a 1:5 ratio. Selected slides from animals at
24 h after injury were stained with Fluoro-Jade C (Chemicon, Temecula, CA) to identify
degenerating neurons following the manufacturer’s instructions.

For immunocytochemistry, sections were processed as previously described (Byrnes et al
2007) using one or more antibodies recognizing the following targets: markers of cell cycle
activation including Cyclin G1 (sc-7865, 1:50, Santa Cruz Biotechnology, Santa Cruz, CA),
and phospho S780 retinoblastoma (Rb) protein (ab47763, 1:100, Abcam, Cambridge, MA);
markers of microglial activation such as CD68 (clone ED1, MCA341R, 1:100, Serotec,
Raleigh, NC), Galectin-3 (ab2785, 6μl/ml, Abcam), p22PHOX (sc-20781, 1:50, Santa Cruz
Biotechnology); the neuronal marker NeuN protein (clone A60, MAB37 at 1:100, Chemicon,
Billerica, MA) and the astroglia marker GFAP (MAB360, 1:400, Chemicon). The fluorescence
microscopy imaging was performed using Zeiss 510 Meta confocal laser scanning microscope
(LSM 510 META, Thornwood, NY) as previously described (Byrnes et al 2007). The images
were taken using the 10X objective at 1024×1024 resolution covering a field of view of
921.36μm × 921.36μm; all images in the same series, including sham, vehicle and roscovitine
using the same antibodies were aquired using the same instrument parameters. By using the
multi-tile image acquisition capabilities of Zeiss LSM 510 META with a motorized stage, 16
images were taken of adjacent areas of the brain. These images were automatically spliced
together to create a final image having an 3685.45 μm × 3685.45 μm field of view at a resolution
of 4096×4096 pixels. Modest variations in image brightness between adjacent panels of the
composite image are intrinsic to this method.

Automatic cell counting in multi-tile fluorescent images obtained as described above was
performed using the ImageJ software, version 1.4 (National Institutes of Health). The indicated
number of images, obtained from independent sections and including the channel of interest
were first converted to 8-bit grayscale using the Image>Type command. Next, the background
was set as indicated using the Image>Adjust>Threshold command followed by cell analysis
including cell counting using the Analyze>Analyze Particles command. All images in the same
series, including vehicle and roscovitine using the same antibodies were processed using the
same analysis parameters and the entire image was used for counting. The numbers shown in
the graphs represent the average number of cells per image for each treatment. Unlike
stereology which offers a quantitative assesment of the total cell number throughout the entire
lesion volume, this method provides a semi-quantitative representation of cell number per
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representative field (the multi-tiled images presented) of 3-5 sections. Detailed instructions are
available at: http://rsbweb.nih.gov/ij/docs/menus/analyze.html.

Unbiased stereology, using the Stereologer 2000 program (SRC, Chester, MD), was applied
for quantitation after standard immunohistochemistry (IHC) staining as previously described
(Byrnes et al 2007). The multi-level sampling design in the Stereologer 2000 software, based
upon the fractionator sampling method, was used to estimate the cell numbers of a particular
phenotype in the injured hemisphere. For cyclin G1 cell counting purposes, the area of injury
was outlined using a 1.5x objective, and cells within each area were counted using a 40X
objective. For phospho Rb cell counting purposes, the area immediately adjacent to the site of
injury was outlined as described above.

Histology
At 21 days following injury, animals were decapitated and tissue processed as above. Slices
were stained with Gill’s hematoxylin, followed by counterstaining in 2.5% eosin and cover-
slipped. Lesion volume was measured based on the Cavalieri method of stereology and
performed on tissue obtained 21 days following injury, as previously described (Byrnes et al
2007). The lesion area, including both the cavity and surrounding damaged tissue, was outlined
using the Stereologer 2000 program to obtain final volume measurements.

Statistics
Continuous variables subjected to repeated measures over a period of time (MWM) were
analyzed using repeated measures ANOVA followed by a one-way at each time point (P<0.05).
T-test and one-way ANOVA were performed for stereologic analysis with significance set at
P<0.05. All continuous data are shown as mean ± SEM. Ordinal measurements (composite
neuroscore) were evaluated using the Kruskal-Wallis test with individual Mann-Whitney U
tests corrected for multiple comparisons. Statistical significance was set at P<0.05.

Results
Roscovitine reduces lesion volume and improves behavioral outcomes following TBI

As shown in Fig. 1, stereological analysis of lesion volume at 21 days following TBI indicated
that treatment with roscovitine decreased brain lesion volume by 37% compared to vehicle-
treated animals (t= 5.073, P<0.001). The average vehicle-treated lesion volume was 20.6
mm3 and the average roscovitine-treated lesion volume was 13.0 mm3. Roscovitine treatment
also significantly improved composite neuroscores compared to vehicle-treated animals at 14
and 21 days following injury (Kruskal Wallis 8.346; P<0.02; Fig. 2A). Individual Mann-
Whitney U tests, corrected for multiple measurements, revealed that vehicle-treated injured
animals achieved significantly lower neuroscores compared to sham (P<0.005), and that
roscovitine improved motor outcome compared to vehicle at both 14 (P<0.02) and 21 days
(P<0.001) post-injury.

Analysis of cognitive function following injury showed a significant effect of time (F3,51 =
24.32; P<0.0001) and treatment (F2,51 = 7.48; P<0.005; Fig. 2B). Latency to platform in the
MWM test in vehicle-treated injured rats was significantly longer on days 16 and 17 post-injury
(P<0.05 and P<0.001, respectivelly), compared to sham-injured animals. However, there was
no significant difference in performance between sham- and roscovitine-treated animals on
day 16, suggesting that roscovitine induced improvement in cognitive function. By day 17
post-injury, cognitive performance in roscovitine-treated injured animals was improved
compared to vehicle-treated injured animals (P<0.05).
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Roscovitine decreases neuronal cell death after TBI
To explore the effects of roscovitine on neuronal survival we performed Fluoro-Jade C staining
after TBI. Fluoro-Jade C specifically stains dying neurons, which become fluorescent green.
As shown in Fig. 3A, tissue obtained 24 h post-injury revealed Fluoro-Jade C-labeled
degenerating neurons at the site of cortical injury lesion in vehicle-treated animals. Animals
treated with roscovitine appeared to have a smaller injury lesion that contained fewer Fluoro-
Jade C positive cells. No significant Fluoro Jade C staining was visible in sham animals (data
not shown). We used the analysis capabilities of the ImageJ software to count Fluoro-Jade-
positive cells in several independent sections such as the one presented, from vehicle and
roscovitine treated animals exposed to TBI; there is a significant decrease in Fluoro-Jade-
positive cells in sections from roscovitine treated animals (Fig. 3B).

Roscovitine significantly attenuates the numbers of neurons positive for markers of cell
cycle activation

In order to explore the mechanisms responsible for the roscovitine-induced neuroprotective
effects, we examined two markers of cell cycle activation, Cyclin G1 and phosphorylated Rb,
which we have previously shown to increase in apoptotic neurons following SCI (Di Giovanni
et al 2003). Staining with NeuN, a DNA-binding neuron specific protein was used to confirm
the presence of cell cycle markers in neurons. Immunocytochemical analysis revealed that at
24 h after injury, in vehicle-treated animals, there is an increased expression of cyclin G1 within
the more central area of the lesion site (Fig. 4A) while phosphorylated Rb was relatively more
present on the periphery of the injury (Fig. 5A). Both markers co-localized with the NeuN
immunostaining, indicating that cell cycle activation occurred in neurons. This eleveted
expression of cyclin G1 and Rb phosphorylation was reduced in tissue from animals treated
with roscovitine (Figs. 4A and 5A) suggesting that the neuroprotective effect of this specific
CDKs inhibitor is associated with down-regulation of cell cycle pathways. We performed cell
counting on several independent sections such as the one presented, using the ImageJ software;
roscovitine treatment results in a significant decrease in the number of cyclin G1 and Phospho-
Rb, Fig. 4B and Fig. 5B respectivelly. No significant cyclin G1 or phospho-Rb immunostaining
was detected in sham animals (data not shown).

In order to obtain a true quantitative assessment of the differences in Cyclin G1 and
phosphorylated Rb between vehicle- and roscovitine-treated animals, stereological analysis
was performed at 24 h post-injury. Injury induced a large increase in both cyclin G1 expression
(F2, 9 = 7.299, P<0.02; Fig. 4C) and phosphorylation of Rb (F2,10 = 27.386; P<0.001; Fig. 5C)
compared to sham. Similar trends are observed with the two methods of cell counting, the semi-
quantitative analysis of immunofluorescent images and quantitative stereology.

Roscovitine decreases activation of astrocytes and microglia after TBI
In order to examine the effects of TBI and cell cycle inhibition on astroglia and microglial
activation, animals were treated with either vehicle or roscovitine after injury and sacrificed 7
days later. In vehicle-treated animals, TBI increased the number of activated astroglia as
evidenced by intensified staining for glial fibrillary acidic protein (GFAP), an indicator of
astrocyte reactive response to CNS injury (Brenner 1994).

Injury also resulted in activation of microglia as indicated by increased staining with four
separate microglia markers - p22PHOX, Galectin-3, ED1 and Iba-1. p22PHOX is a critical
component of the microglia NADPH Oxidase complex (DeLeo and Quinn 1996), responsible
for reactive oxygen species (ROS) generation and involved in microglia proliferation/
activation (Byrnes et al 2006). The activated microglia indicated by p22PHOX infiltrated the
core of the lesion site whereas activated astroglia appeared to surround the lesion site. (Fig.
6A). In contrast, animals treated with roscovitine showed decreased expression of both GFAP-
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positive astroglia as well as p22PHOX positive microglia (Fig. 6A), suggesting that cell cycle
inhibition attenuates both astrocyte activation and microglial activation associated with brain
injury. Cell counting on several similar sections using the ImageJ program shows the significant
decrease in the numbers of GFAP and p22PHOX-positive cells following roscovitine treatment
(Fig. 6A).

In vehicle-treated animals, TBI induced an increase in the number of activated microglia as
evidenced by staining for ED1, a lysosomal membrane glycoprotein that is a marker of
microglial phagocytic activation (Damoiseaux et al 1994) (Fig. 6B). The ED1-positive
microglia are not co-stained with Cyclin G1, suggesting that induction of this cell cycle protein
is not involved in microglia activation. Animals treated with roscovitine showed decreased
expression of ED1 positive microglia, suggesting that cell cycle inhibition attenuates microglial
activation associated with injury. Cell counting on similar sections using the ImageJ program
shows a significant decrease in the number of ED1-positive cells following roscovitine
treatment (Fig. 6B). The presence of activated microglia in the lesion site after TBI was also
confirmed by immunostaining for Galectin-3 (MAC-2 antigen, a beta-galactoside-specific
lectin), which is selectively expressed by activated microglia in the brain (Walther et al
2000). In vehicle-treated animals, TBI increased the number of microglia with intense
Galectin-3 staining in the injury core (Fig. 6C). Animals treated with roscovitine showed a
marked decrease in Galectin-3-positive microglia, suggesting that cell cycle inhibition
attenuates microglia activation associated with brain injury. Cell counting on similar sections
using the ImageJ program demonstrates a significant decrease in the numbers of Galectin-3-
positive cells following roscovitine treatment (Fig. 6C). Finally, microglia activation was also
confirmed by immunostaining for Iba-1, which is a calcium-binding protein that is specifically
expressed in brain microglia and upregulated upon microglia activation (Ito et al 2001). In
vehicle-treated animals, TBI increased the number of microglia with strong Iba-1 staining in
the injury core (Fig. 6D). Animals treated with roscovitine showed a marked decrease in Iba-1-
positive microglia, further confirming that cell cycle inhibition attenuates microglial activation
associated with brain injury. Cell counting on similar sections using the ImageJ program
demonstrated a significant decrease in the numbers of Iba-1-positive cells following roscovitine
treatment (Fig. 6D). No significant cyclin G1, Galectin-3, p22PHOX or GFAP immunostaining
was detected in sham animals (data not shown).

Roscovitine decreases activation of primary microglia in in vitro culture models
To further investigate the potential of roscovitine to attenuate microglial activation, we used
an in vitro culture system based on primary rat brain microglia stimulated by lipopolysacharide
(LPS). Pre-treatment with roscovitine significantly attenuated markers of microglial activation
such as proliferation (Fig. 7A) and release of NO, a well known neurotoxic agent (Fig. 7B). In
this model we also examined other CDK inhibitors with relatively narrow specificities,
including a CDK1-selective inhibitor and a CDK4-selective inhibitor. The CDK1 inhibitor is
approximatelly 5 times more selective for CDK1 compared to CDK5 (Andreani et al 2000).
The CDK4 inhibitor is 500 times more selective for CDK4 compared to CDK2 (Kubo et al
1999). Pre-treatment with both CDK1 and CDK4 inhibitors significantly attenuated both
microglial proliferation (Fig. 7C) and release of NO (Fig. 7D).

We used an in vitro model of mixed primary brain microglia-neuronal cultures to evaluate the
potential of roscovitine to attenuate microglial-dependent neurotoxicity. Pre-treatment of
microglia with roscovitine before LPS treatment for 24 h significantly attenuated the ability of
microglial conditioned media to induce neuronal cell death (Fig. 7E). These data suggest that
roscovitine decreases release of neurotoxic compounds by activated microglia.

Finally, we examined the effects of roscovitine as well as other CDK inibitors in a well
established model of neuronal apoptosis induced by etoposide. In addition to roscovitine,
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CDK1 and CDK4 inhibitors, we also used Purvalanol A, a compound that has a CDK inhibitory
profile similar to roscovitine and may be used to confirm roscovitine-based data indicating the
involvement of CDKs in a process (Bain et al 2007). As shown in Fig.7F, all of the tested
CDKs inhibitors were able to significantly attenuate etoposide-induced neuronal cell death,
suggesting the involvement of multiple CDKs in neuronal apoptosis.

Discussion
Over the past several years our group has studied the role of cell cycle activation in the
pathophysiology of CNS trauma. After SCI (Byrnes and Faden 2007; Di Giovanni et al
2003) or TBI (Cernak et al 2005) in rats, increased expression of cell cycle proteins occurred
in neurons showing caspase-3 activation and morphological signs of apoptosis. Cell cycle
activation after TBI was also associated with astrogliosis and microglial activation (Di
Giovanni et al 2005). Treatment with flavopiridol reduced behavioral and histological
abnormalities after TBI (Di Giovanni et al 2005) and SCI (Byrnes et al 2007). Protective effects
of flavopiridol have also been reported in cerebral ischemia (Wang et al 2002).

Flavopiridol, a semi-synthetic flavonoid, is a potent but non-selective competitive CDK
inhibitor acting on all CDKs thus far examined (Newcomb 2004). Unfortunately, it also
potently inhibits the positive transcription elongation factor b (P-TEFb, of which CDK9 is a
component) and consequently acts as a global suppressor of transcription (Monaco et al
2004). In contrast, roscovitine is a purine analogue that competitively inhibits CDKs in a more
selective fashion, acting preferentially on CDK 1, 2, and 5 and possibly CDK7 and 9 (Meijer
et al 1997). It poorly inhibits CDK4 and 6 (Meijer et al 1997) and does not significantly inhibit
members of most other kinase families (Bain et al 2003). Overall, multiple studies have
confirmed that roscovitine is among the most potent and specific CDK inhibitors (Bach et al
2005; Bain et al 2007; Meijer et al 1997). Moreover, although roscovitine can inhibit CDK9
in vitro, it does not appear to interact with it in vivo; this may explain why, unlike flavopiridol,
roscovitine does not globally inhibit gene expression (Lam et al 2001). Because both RNA and
protein synthesis may be required for induction of neuronal apoptosis, it is likely that the ability
of flavopiridol to attenuate neuronal cell death reflects in part to its transcriptional repressor
role. Therefore, to better address whether activation of CDKs/cell cycle activation is an
important mechanism for TBI-induced cellular changes and related functional deficits, we
examined the effect of roscovitine treatment.

Central administration of a single dose of roscovitine 30 min after injury markedly decreased
lesion volume and significantly improved behavioral outcomes compared to vehicle-treated
animals. Quantitative stereological techniques and high resolution confocal microscopy were
used to characterize the molecular and cellular changes induced by TBI and its modulation by
roscovitine. Following TBI, activation of neuronal cell cycle pathways—including
phosphorylation of Rb protein and increased expression of cyclin G1—as well as neuronal cell
death occur within 24 h; considerable microglial and astrocyte activation/proliferation were
detected by 7 days. Roscovitine treatment significantly attenuated each of these changes. At
24 h, roscovitine-treated animals showed decreased numbers of neurons positive for
phosphorylated-Rb and cyclin G1 as compared to controls and fewer degenerating neurons
indicated by decreased Fluoro-Jade C staining. At 7 days post-injury, roscovitine treatment
reduced microglial activation as demonstrated by reduced numbers of cells positive for ED1,
Galectin-3 and p22PHOX, and decreased astrocyte activation as indicated by fewer GFAP-
positive cells. Decreased numbers of cyclin G1-positive cells were also found at this later time
point, suggesting that roscovitine-induced inhibition of cell cycle activation after a single early
injection is sustained.
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The mechanisms by which the active cyclins/CDKs complexes induce neuronal apoptosis are
being clarified. One of the signal transduction pathways involved includes cyclin D-dependent
CDK4/6 which phosphorylates Rb on specific residues. Phosphorylation of Rb causes
dissociation of Rb from the Rb/E2Fs complex, with activation of E2Fs transcription factors;
E2Fs induce apoptosis by upregulating cell death mechanisms such as activation of B- and C-
myb genes; by increasing expression of caspases 3, 9 and 8 and Apaf-1; and through activation
of p53 and p73. These activities lead to increased expression of pro-apoptotic Bcl-2 family
members and release of mitochondrial pro-apoptotic proteins (Nguyen et al 2003). Recent
reports indicate that in some models of neuronal cell death activation of CDK5 is upstream of
CDK4/6 and that CDK5 can directly phosphorylate Rb and initiate neuronal cell death
(Hamdane et al 2005). CDK5 is implicated in neurodegeneration and cell death; knockout of
CDK5 results in neuroprotection after focal brain ischemia (Rashidian et al 2005). CDK2 can
also phosphorylate Rb (Lundberg and Weinberg 1998). As roscovitine has no activity against
CDK4 and CDK6, but is highly potent against CDK2 and CDK5 (Meijer and Raymond
2003), our data suggest that activation of CDK2 and/or CDK5 may contribute to neuronal cell
death after TBI and that roscovitine might downregulate Rb phosphorylation by inhibiting
CDK2/5. It is important to underscore that specificity limitations common to pharmacological
interventions, such as the one used in our study, do not allow a determination of the precise
CDK that is targeted by roscovitine and is responsible for the protective effects observed.
Furthermore, our data do not exclude the possibility that other CDKs besides CDK2 or CDK5
are involved in neuronal cell death or other cellular processes that are active in our model. As
discussed above, multiple CDKs are often involved in sequential and/or parallel activation
cascades when modulating cellular activity. Therefore, treatment effects may result from
interventions at multiple points in the reaction cascade. Our in vitro data are consistent with
this conclusion, showing that in addition to roscovitine and purvalanol A, which target multiple
CDKs, etoposide-induced neuronal cell death and/or primary microglial activation in culture
are also attenuated by somewhat selective CDK1 and CDK4 inhibitors. In addition, published
reports indicate that significant redundancy exists in CDK signaling. For example, CDK2
knockout mice are viable and show no significant proliferation effects, despite previous data
indicating an important function for CDK2 in the cell cycle; this suggests that other CDKs may
be able to compensate for the loss of CDK2 (Berthet et al 2003). Thus, targeting multiple CDKs
may provide better neuroprotection than more selective inhibitors.

A role for increased Cyclin G1 expression and Rb phosphorylation in neuronal cell death has
also been suggested in other experimental models, including ischemia, excitotoxicity, and
neurodegeneration (Sultana and Butterfield 2007). Cyclin G1 immunoreactivity and mRNA
are low in mature rodent brain; however, following injury, expression increases in the nuclei
of damaged neurons. Cyclin G1 positive neurons also correlate strongly with degenerating
neurons in a model of permanent middle cerebral artery occlusion (MCAO) (Maeda et al
2005).

Phosphorylated Rb induced by hypoxia-ischemia and MCAO is expressed in pyknotic cells
and neurons both in the injury core and peri-infarct regions (Rashidian et al 2005). In our
model, Cyclin G1 was expressed preferentially, albeit not exclusively, in neurons in the central
area of the lesion, whereas phosphorylated Rb was expressed relatively more in the neurons
toward the periphery of the injury lesion. This might suggest differential activation of cell cycle
components in the central lesion area versus penumbra, although variations in the time course
of cell cycle activation may provide an alternative explanation.

Cyclin G1 over-expression induces cell death (Okamoto et al 1999), although the mechanisms
responsible for cyclin G1 induction following injury and related neuronal cell death are not
well characterized. Some recent data suggest that cyclin G1 is a target gene of the p53 tumor
suppressor protein, a well-known inducer of apoptotic cell death. In this case, cyclin G1 would
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be downstream of the signaling pathway involving phosphorylation of Rb and activation of
E2Fs transcription factors that lead to p53 activation. Other data indicate that Cyclin G1 is
associated with CDK5 and plays a role in G2/M transition (Seo et al 2006); under these
conditions increased activation of cyclin G1 may induce apoptosis of mature neurons that are
unable to divide.

While CNS injury-induced aberrant cell cycle activation induces apoptosis in post-mitotic
cells, it initiates proliferation in mitotic CNS resident cells such as astrocytes and microglia
(Takuma et al 2004). The functional significance of microglial proliferation and microglial
activation has been debated. On the one hand, activated microglia produce various pro-
inflammatory molecules, such as IL-1β, NO, complement components, MCP-1, osteopontin,
MHC class I and II and ROS (produced by the NADPH oxidase enzyme) and these have been
implicated in secondary injury (Cernak et al 2005). On the other hand, microglial-related
factors such as TNFα may participate in both secondary injury and recovery (Tamatani et al
1999), whereas others such GDNF may provide endogenous neuroprotection (Hashimoto et
al 2005). Similarly, although astrocytes play an important role in maintaining normal brain
function, changes after injury such as swelling and/or hypertrophy (astrogliosis) as well as
proliferation (astrocytosis) may serve pathophysiological actions (Cernak et al 2005). For
example, the glial scar associated with astrocytosis may inhibit regeneration and plasticity after
brain injury (Silver and Miller 2004). A recent in vitro study of ischemia has suggested that
the neurotoxic versus neuroprotective actions of activated microglia may in part reflect injury
severity (Lai and Todd 2008).

We have shown previously that cell cycle proteins are up-regulated in microglia after SCI as
well as in primary microglia in vitro (Byrnes et al 2006) and that activation of astrocytes and
microglia occur after SCI and are correlated with cell cycle initiation (Byrnes et al 2007).
Another group has reported cell cycle activation in microglia after SCI and protective actions
by the cell cycle inhibitor olomoucine (Tian et al 2007). We established with a high degree of
confidence the post-injury microglia status in the brain by using four independent markers of
microglia activation: ED1, Galectin-3, p22PHOX and Iba-1 (Byrnes et al 2006; Ito et al 2001).
The present studies demonstrate that microglial activation occurs after TBI, as indicated by the
greatly increased number of cells positive for the three markers. These changes are attenuated
by roscovitine. Roscovitine treatment also inhibited TBI-induced activation of astrocytes as
shown by decreased staining with GFAP-marker of astrocyte reactive response (Brenner
1994). Because the complex cellular environment in the brain makes it difficult to determine
with precision the primary action of any pharmacological agent, we used cell culture models
of primary microglia and neurons to analyze the effects of roscovitine on specific cell types.
In previous in vitro studies we have demonstrated that roscovitine is protective against neuronal
cell death resulting from etoposide-induced DNA damage and also that roscovitine inhibits
astrocyte proliferation (Cernak et al 2005). In the present study we focused on the effects of
roscovitine on primary microglia using a well established model of LPS-induced activation.
In this model, roscovitine attenuated microglial proliferation and the release of neurotoxic
molecules such as NO induced by LPS. Furthermore, using a model of mixed primary
microglia/neuronal cultures, we show that roscovitine markedly reduced microglial-dependent
neurotoxicity. CDK1 and CDK4 inhibitors also attenuate microglia activation in our in vitro
model, suggesting complexity of the CDK cascade that regulates microglia functions.

In conclusion, roscovitine treatment after TBI markedly reduces lesion volume and improves
behavioral outcome. Treatment attenuates cell cycle activation in neurons, astrocytes and
microglia; effects are associated with reductions in neuronal apoptosis, glial scar formation
and microglial activation. These diverse effects of roscovitine are supported by complementary
cell culture observations, and such pluripotential actions may explain its robust neuroprotective
activity.
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Fig. 1.
Treatment with roscovitine, 30 min following TBI, significantly decreases lesion volume.
Lesion volume was measured 21 days following injury and compared to vehicle-treated
animals (t=5.073, ****P<0.001; n=7-8 per group).
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Fig. 2.
Administration of roscovitine significantly attenuates functional deficits induced by TBI. (A)
Roscovitine improved motor function, as measured by the composite neuroscore at 14 and 21
days following injury (each n=7-8). Vehicle-treated injured animals show significantly lower
neuroscores compared to sham animals at all time points (P<0.005); injured animals treated
with roscovitine show improved motor function compared to vehicle-treated injured animals
at 14 day (**P<0.02) and 21 days (****P<0.001) after injury. (B) Treatment with roscovitine
significantly improves performance on the Morris water maze. Vehicle-treated injured animals
demonstrate a significantly longer latency to platform compared to sham animals by 16
(P<0.05) and 17 (P<0.001) days post-injury. Injured animals treated with roscovitine had a
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significantly shorter latency to platform by 17 days after injury compared to vehicle-treated
injured animals (*P<0.05).
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Fig. 3.
Roscovitine treatment decreases neuronal cell death as indicated by Fluoro Jade C staining 24
h after injury. (A) Vehicle-treated animals demonstrate a large lesion injury containing many
degenerating neurons (Fluoro Jade C positive) whereas the roscovitine-treated animals showed
a decreased lesion area and fewer Fluoro Jade C positive neurons. The image insets are
generated from the same file as the main confocal image and present at higher magnification
an area from the indicated region. (B) Cell counting using ImageJ indicates that roscovitine
treatment results in a significant decrease in Fluro Jade-positive cells per brain section (n=4
sections, threshold=50, unpaired t test, **** P=0.0004).
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Fig. 4.
Roscovitine treatment significantly decreases expression of Cyclin G1 in neurons 24 h after
injury. (A) Representative composite confocal images after double-immunostaining for cyclin
G1 (green) and NeuN, neurons-specific antigen (red) of the lesion injury show the decrease in
the number of neurons positive for cyclin G1 immunostaining (colocalization indicated yellow
color) in roscovitine compared to vehicle. The separate NeuN and cyclin G1 images are also
shown for both vehicle- and roscovitine-treated animals, respectively. The image insets are
generated from the same file as the main confocal image and present at higher magnification
an area from the indicated region. (B) Cell counting using ImageJ indicates that roscovitine
treatment results in a significant decrease in Cyclin G1-positive cells per brain section (n=5
sections, threshold=99, unpaired t test, **** P=0.0002). (C) Quantitative assessment using
stereology demonstrates that injury increases expression of Cyclin G1 compared to sham-
treated animals (P<0.02), and that roscovitine treatment significantly decreased the number of
cyclin G1 positive cells compared to vehicle (n=3-4; *P<0.05), although not to levels observed
in sham animals (P<0.05).
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Fig. 5.
Roscovitine treatment significantly attenuates the phosphorylation of Rb in neurons 24 h after
injury. (A) Representative composite confocal images after double-immunostaining for
phospho-Rb (green) and NeuN, neurons-specific antigen (red) of the lesion injury show the
decrease in the number of neurons positive for phospho-Rb immunostaining (colocalization
indicated yellow color) in roscovitine compared to vehicle. The separate NeuN and phospho-
Rb images are also shown for both vehicle- and roscovitine-treated animals, respectively. The
image insets are generated from the same file as the main confocal image and present at higher
magnification an area from the indicated region. (B) Cell counting using ImageJ indicates that
roscovitine treatment results in a significant decrease in phospho-Rb-positive cells per brain
section (n=4 sections, threshold=29, unpaired t test, **** P<0.0001) (C) Quantitative
assessment using stereology demonstrates that injury increases phosphorylated Rb compared
to sham (F2,10 = 27.386, P<0.001) and treatment with roscovitine significantly decreases the
number of phospho-Rb positive cells compared to vehicle (***P<0.002).
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Fig. 6.
Roscovitine treatment decreases activation of microglial and astroglia at 7 days after injury,
as indicated by immunostaining for p22PHOX, ED1, Galectin-3 and GFAP. All images are
cropped from the indicated areas of larger multi-tile images (data not shown); multi-tile images
are used for the cell counting data presented. (A) Representative composite confocal images
after double-immunostaining for GFAP (red) and p22PHOX (green) of the core and periphery
of the injury show that injury-dependent increase in the number of p22PHOX-positive microglia
is concentrated in the core, whereas the increase in GFAP-positive astroglia, occurs especially
in the periphery of the lesion. Roscovitine attenuated both changes. There is no colocalization
between markers for microglia and astroglia. Images showing the separate p22PHOX and GFAP
channels are included. Cell counting using ImageJ indicates that roscovitine treatment results
in a significant decrease in both p22PHOX (n=3 sections, threshold=50, unpaired t test, **
P=0.0029) and GFAP-positive cells (n=3 sections, threshold=150, unpaired t test, * P=0.0298)
per brain section. (B) Representative composite confocal images after double-immunostaining
for ED1 (red) and cyclin G1 (green) of the injury core show the increased number of ED1-
positive microglia after TBI. These cells do not have increased cyclin G1 staining. Roscovitine
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treatment attenuated the ED1 staining increase. There is no colocalization between ED1 and
cyclin G1 immunostaining. Images with separate ED1 and cyclin G1 channels are also shown
for both vehicle- and roscovitine-treated animals, respectively. Cell counting using ImageJ
indicates that roscovitine treatment results in a significant decrease in ED1-positive cells (n=3
sections, threshold=50, unpaired t test, **** P<0.0001) per brain section. (C) Representative
composite confocal images after immunostaining for Galectin-3 (red) and staining with TO-
PRO-3 (blue, DNA stain) of the area of the injury core illustates the increased number of
Galectin-3-positive microglia. Roscovitine treatment attenuated the increased Galectin-3
staining. The separate Galectin-3 and TO-PRO-3 images are also shown for both vehicle- and
roscovitine-treated animals, respectively. Cell counting using ImageJ indicates that roscovitine
treatment results in a significant decrease in Galectin-3-positive cells (n=4 sections,
threshold=50, unpaired t test, **** P<0.0001) per brain section. (D) Representative composite
confocal images after immunostaining for Iba-1 (green) and staining with TO-PRO-3 (blue,
DNA stain) of the area of the injury core illustates the increased number of Iba-positive
microglia. Roscovitine treatment attenuated the increased Iba-1 staining. The separate Iba-1
and TO-PRO-3 images are also shown for both vehicle- and roscovitine-treated animals,
respectively. Cell counting using ImageJ indicates that roscovitine treatment results in a
significant decrease in Iba-1-positive cells (n=4 sections, threshold=50, unpaired t test, ****
P<0.0001) per brain section.
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Fig. 7.
Roscovitine reduces activation of primary microglia and primary neuronal cell death in in
vitro culture models. Primary rat microglia were incubated with LPS (1μg/ml) for 24 h and
activation was determined by proliferation assays (A, C), release of NO (B, D) as well as
neurotoxicity assays (F). Microglial proliferation was assessed using the MTS assay.
Stimulation of primary microglial cultures with LPS (1μg/ml) for 24 h significantly increases
microglial proliferation. Pre-treatment of microglia with roscovitine (Ros, 100μM) (A) or other
CDK inhibitors at the indicated doses (B) for 1 h results in a significant attenuation of microglia
proliferation. Bars represent mean +/- SEM; **P<0.001 in comparison to control; ##P<0.001
in comparison to LPS. Microglial activity was assessed by measuring the production of nitric
oxide (NO) at 24 h after stimulation with LPS. Stimulation of primary microglial cultures with
LPS significantly increases NO production. Pre-treatment of microglia with roscovitine (Ros,
100μM) (C) or other CDK inhibitors at the indicated doses (D) for 1 h results in a significant
inhibition of NO production. Bars represent mean +/- SEM; **P<0.001 in comparison to
control; ##P<0.001 in comparison to LPS. (E) To determine neurotoxicity, conditioned media
from microglia stimulated for 24 h with LPS was transferred to primary rat neurons. After an
additional 24 h, neuronal viability was assayed by measuring LDH release. Conditioned media
from microglia pre-treated with roscovitine (100μM) for 1 h prior to LPS stimulation results
in a complete inhibition of microglial-induced neuronal death. Bars represent mean +/- SEM;
*P<0.05 in comparison to control; ##P<0.001 in comparison to LPS. (F) To determine
neuroprotection, primary cortical neurons were pretreated with the indicated doses of
roscovitine and other CDK inhibitors, then exposed to etoposide (50μM) for 24 h followed by
determination of neuronal viability assayed by measuring LDH release. Roscovitine as well as
the other CDK inhibitors resulted in significant attenuation of of etoposide-induced neuronal
death. Bars represent mean +/- SEM; *P<0.05 in comparison to control; ##P<0.001 in
comparison to etoposide alone.
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